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Warning

This product contains chemicals, including lead, known to the
State of California to cause cancer and birth defects or other
reproductive harm. Wash hands after handling.

Communications & Safety Regulation Information

Compliance Statement
The model 192 1/0 complies with the following standards
regulating interference and EMC:

FCC Part 15 Class A

EN55103 - 1, environment E4

EN55103 - 2, environment E4

AS/NZS 3548 Class A

Radio and Television Interference

This equipment has been tested and found to comply with the
limits for a Class A digital device, pursuant to Part 15 of the
FCC Rules.

Communications Statement

This equipment has been tested to comply with the limits for a
Class A digital device. Changes or modifications to this

192 1/0 not authorized by Digidesign, Inc., could void the
Certification and negate your authority to operate the 192 1/0.
This 192 |/0 was tested for CISPR compliance under
conditions that included the use of peripheral devices and
shielded cables and connectors between system components.
Digidesign recommends the use of shielded cables and
connectors between system components to reduce the
possibility of causing interference to radios, television sets,
and other electronic devices.

Safety Statement

This equipment has been tested to comply with USA and
Canadian safety certification in accordance with the
specifications of UL Standards; UL1419 and Canadian CSA
standard; CSA C22.2 No.1-M90. Digidesign Inc., has been
authorized to apply the appropriate UL & CUL mark on its
compliant equipment.



Important Safety Instructions Disposal of Waste Equipment by Users in the
When using electric or electronic equipment, basic precautions European Union
should always be followed, including the following:
Read all instructions before using this equipment.
To avoid the risk of shock, keep this equipment away from -
rain water, and other moisture. Do not use this equipment
if it is wet.
The equipment should only be connected to the correct
rating power supply as indicated on the 192 1/0. O\
Do not attempt to service the equipment. There are no
user-serviceable parts inside. Please refer all servicing to
authorized Digidesign personnel.
Any attempt to service the equipment will expose you to a
risk of electric shock, and will void the manufacturer’s
warranty.

This symbol on the product or its packaging indicates that this

product must not be disposed of with other waste. Instead, it

is your responsibility to dispose of your waste equipment by

handing it over to a designated collection point for the recycling

Warning! of waste electrical and electronic equipment. The separate

. . o collection and recycling of your waste equipment at the time of

HD aUd"_) interfaces nee_d room at their sides to maintain disposal will help conserve natural resources and ensure that
proper air flow and cooling. it is recycled in a manner that protects human health and the
Do not' install these un|ts‘|nto a ‘rack or other gnclosure that environment. For more information about where you can drop
doesn't leave room on either S'd_e for the unit fans. off your waste equipment for recycling, please contact your
Do not block the sides of the units (where fans are), or local city recycling office or the dealer from whom you

disconnect the fan.
urchased the produ
If the units are racked up in a case, remove all lids, doors, P P

or covers before operating the units.
Failure to do so can result in the units overheating very
quickly, which can permanently damage them.
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Introduction to the 192 1/0

The Digidesign 192 I/O™ 16-channel digital au-
dio interface is for use in a Pro Tools|HD system
and features 24-bit analog-to-digital (A/D) and
digital-to-analog (D/A) converters. The 192 I/O
supports sample rates of up to 192 kHz for supe-
rior dynamic range and low noise floor.

192 1/0 Features

e 16 discrete channels of input and output,
with 4-segment LED Meters to monitor input
and output on each channel. Input and Out-
put channels can include:

e Eight channels of 24-bit D/A and A/D con-
verters for superior analog input and out-
put at sample rates of 44.1 kHz, 48 kHz,
88.2 kHz, 96 kHz, 176.4 kHz, and 192 kHz

e Ten channels of 24-bit-supported AES/EBU
1/0. Eight-channel AES/EBU I/O supports
sample rates of up to 96 kHz on all chan-
nels, and of up to 192 kHz on four chan-
nels simultaneously. Two-channel AES-
EBU /O supports sample rates of up to
96 kHz.

e Sixteen channels of Optical I/O, through
two pairs of Lightpipe (ADAT) connectors;
one pair of optical ports can be switched to
two channels of optical S/PDIF I/0

e Two 24-bit-capable S/PDIF I/O supporting
sample rates of up to 96 kHz

Real-time sample rate conversion on inputs of
eight channels of either AES/EBU, Optical, or
TDIF.

External Clock input and output for synchro-
nizing 192 I/O with external 1x Word Clock
or 256x (Slave Clock) devices.

Legacy Port for Digidesign-qualified
Pro Tools|24 MIX audio interfaces.

Optional addition of cards to expand analog
or digital I/O.

Simultaneous use of multiple Pro Tools|HD
audio interfaces to further expand system in-
put and output. For more information see the
Expanded Systems Guide.

What’s Included

* 1921/0

e AC power cable

e DigilLink cable (1.5ft. [0.46m])

e BNC cable (1.5ft. [0.46m])

e Digidesign Registration Information Card
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System Requirements

The Digidesign 192 I/O requires a Digidesign-
qualified Pro Tools|HD system.

Compatibility Information

Digidesign can only assure compatibility and
provide support for hardware and software it has
tested and approved. For a list of Digidesign-
qualified computers, operating systems, hard
drives, and third-party devices, refer to the
Digidesign Web site (www.digidesign.com).

About This Guide

This guide provides a hardware overview of the
192 1/0.

Complete instructions for connecting and con-
figuring the 192 I/O for your Pro Tools|HD sys-
tem are located in the Pro Tools|HD Getting
Started Guide. For additional information about
using Pro Tools software to route your interface
inputs and outputs to Pro Tools inputs and out-
puts, see the Pro Tools Reference Guide.
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Conventions Used in This Guide

Digidesign guides use the following conven-
tions to indicate menu choices and key com-
mands:

Convention Action

File > Save Choose Save from the File
menu

Control+N Hold down the Control key
and press the N key

Control-click Hold down the Control key
and click the mouse button

Right-click Click with the right mouse
button

The following symbols are used to highlight im-
portant information:

@ User Tips are helpful hints for getting the
" most from your system.

A\ Important Notices include information that
could affect your data or the performance of
your system.

Shortcuts show you useful keyboard or
mouse shortcuts.

Cross References point to related sections in
this guide and other Digidesign guides.



About www.digidesign.com

The Digidesign website (www.digidesign.com)
is your best source for information to help you
get the most out of your Pro Tools system. The
following are just a few of the services and fea-
tures available.

Product Registration Register your purchase on-
line. See the enclosed Digidesign Registration
Information Card for instructions.

Support and Downloads Contact Digidesign
Technical Support or Customer Service; down-
load software updates and the latest online
manuals; browse the Compatibility documents
for system requirements; search the online An-
swerbase; join the worldwide Pro Tools commu-
nity on the Digidesign User Conference.

Training and Education Become a certified

Pro Tools Operator or Expert; study on your
own using courses available online, or find out
how you can learn in a classroom setting at a
certified Pro Tools Training Center.

Products and Developers Learn about Digidesign
products; download demo software; learn about
our Development Partners and their plug-ins,
applications, and hardware.

News and Events Get the latest news from Digi-
design; sign up for a Pro Tools demo.

To learn more about these and other resources
available from Digidesign, visit the Digidesign
website (www.digidesign.com).
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192 1/0 Overview

This chapter describes the front and back panel features of the 192 I/O.

See the Pro Tools|HD Getting Started Guide for complete system installation and configuration instruc-
tions. If you are adding the 192 1/O to an existing system, see the Expanded Systems Guide.

192 1/0 Front Panel
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192 I/0 Front Panel

Power Switch and LED Ring

This button turns the 192 I/O on and off.

The LED ring around the power button will light
green to indicate that the unit has powered up
successfully and is connected to an active

Pro Tools|HD system. If the LED ring is orange,
the unit has power, but the computer it is con-
nected to is shut down.

Sample Rate

These LEDs display the current sample rate of
the 192 I/O internal crystal oscillator: 44.1 kHz,
48 kHz, 88.2 kHz, 96 kHz, 176.4 kHz, or

192 kHz. The sample rate can be set in Pro Tools
when you create a new session, or in the Hard-
ware Setup or Playback Engine dialogs if no ses-
sion is open.
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Loop Master LED

The LOOP MASTER LED indicates which

Pro Tools|HD audio interface is the master

Pro Tools peripheral. The Loop Master LED will
be continuously lit on the current Loop Master
peripheral only, and unlit on all other peripher-
als. (Only one Pro Tools|HD I/O can be Loop
Master at a time.) The Loop Master LED will al-
ways be lit with a single interface.

Loop Master defaults to the first Pro Tools|HD
peripheral connected to the primary, or “core”
Pro Tools|HD card. On Pro Tools|HD (for PCle)
this is the Accel Core card. On Pro Tools|HD (for
PCI) this is the HD Core card.

Sync Mode LEDs

The SYNC MODE LEDs indicate the current
Clock Source as set in Pro Tools.

INT (Internal) Indicates the 192 I/O sample clock
is generated by its internal crystal oscillator, as
determined by the session Sample Rate.

DIG (Digital) Indicates that an external AES/EBU,
TDIF, Optical (ADAT), or S/PDIF device is pro-
viding system clock. If no valid clock source is
detected, 192 1/O will switch to INT, the DIG
LED will flash, and an error message will appear
on-screen in Pro Tools.

If at least two channels are not assigned from
the selected digital port in the Main page of the
Hardware Setup dialog, or if no valid clock
source is detected at this port, 192 I/O will
switch to INT and the DIG LED will flash.

LOOP (Loop Master) Indicates that the 192 [/O is
slaving to another Pro Tools|HD I/O through
Loop Sync. You do not set LOOP mode any-
where in the software. This is done automati-
cally when you choose another peripheral as
LOOP MASTER.
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EXT (External) Indicates that the 192 I/O is us-
ing the EXT CLOCK IN port for system synchro-
nization.

External Clock input and output do not have to
be at the Word clock rate. EXT CLOCK IN syn-
chronization will typically be 1x the current ses-
sion sample rate. However, for sample rates
higher than 48 kHz, the 192 I/O will generate a
choice of 1x or a base rate of 44.1 kKHz or 48 kHz,
depending upon the higher rate, as follows:

Session Sample Rate | Word Clock Support
44.1 kHz 44.1 kHz

(or 256x out)
48 kHz 48 kHz

(or 256x out)
88.2 kHz 88.2 kHz

44.1 kHz
96 kHz 96 kHz

48 kHz
176.4 kHz 176.4 kHz

44.1 kHz
192 kHz 192 kHz

48 kHz

Meters

These four-segment LEDs indicate signal level
for each of the sixteen channels. The top row of
meters indicates input levels, and the bottom
row shows output levels. These meters are cali-
brated at —-42 dB, -18 dB, -6 dB, and 0 dB, respec-
tively.

Q Note that 0 dB is not to be confused with
" clipping; use the on-screen meters in
Pro Tools to determine whether a signal is
clipping. See the Pro Tools Reference Guide.



192 1/0 Back Panel

Bay 1: Analog In Card

Bay 3: Digital 1/0 Card

Enclosure

—
ANALOG INPUT DIGITAL /0
+4 dBu BALANCED 10 4BV BALANCED

AeseR SF peLoP ST
AoAT  ADAT r 1 r.

AAAAAAAA

Bay 2: Analog Out Card

192 I/0 back Panel

Although the 192 I/O is a 16-channel audio in-
terface, it has up to 50 inputs and outputs avail-
able through its various back panel connectors.

Input and Output Cards

The 192 1/0 features four bays for I/O cards.
Bays 1-3 contain Analog In, Analog Out, and
Digital I/O cards, respectively. The fourth bay is
an expansion bay, for which you can purchase
an additional audio card of your choice.

Installing an optional A/D, D/A, or D/D card
provides even more I/O (up to a maximum pos-
sible 74 inputs and outputs). See Appendix A,
“Adding or Removing I/O Cards.”

Empty Bay for Optional Card

G:

EXPAYSON PORT PRIVAY PORT

Analog Input

This section contains connectors for analog au-
dio input with 24-bit, 192 kHz A/D converters.
Input is provided through two discrete DB-25
connectors. You can connect sources at both op-
erating levels and choose between them from
within Pro Tools. The two inputs are:

+4 dBu Balanced Provides eight balanced input
channels at +4 dBu nominal operating levels.

-10 dB(V) Balanced Provides eight balanced in-
put channels at -10 dB(V) nominal operating
levels.

For wiring information, see Appendix B, “Pi-
nout Diagrams for the DB-25 Connectors.”

For each channel, you can select input level and
Input Trim settings from within the Hardware
Setup dialog. (For instructions, see the

Pro Tools|HD Getting Started Guide.)
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Input Trims

Two dedicated Input Trims per analog input
channel provide further calibration options and
flexibility. Depending on how you utilize the
two DB-25 input ports, you can use the A and B

trim settings for numerous applications. See “In-

put Trims” on page 11.

In addition, the soft-clip limiter function helps
avoid digital clipping. See “Input Trims” on
page 8, and “Soft Clip Limiting” on page 12.

Analog Output

This section contains a single DB-25 connector
and Output Trims for eight channels of analog
audio output. These balanced outputs operate at
+4 dBu levels. See Appendix B, “Pinout Dia-
grams for the DB-25 Connectors.”

Q For —10 dB(V) gear, a special DigiSnake ca-
ble (sold separately) is available. If you want
to make your own cable, be sure to use in-line
transformers or resistor networks to properly
pad the +4 dBu output to —-10 dB(V) levels.

Output Trims

The Output Trims below the DB-25 connector
are used to individually calibrate each channel’s
output level.

Two sets of Output Trims are provided for each
channel allowing you to store a second set of
headroom values. This allows you to match two
different headroom values for either input con-
nector. For more information, see “About Input
Operating Levels” on page 11.

Q Most consumer electronics operate at
—10 dB(V) levels, and may not feature bal-
anced inputs and outputs. You can connect
—10 dB(V) signals to the —10 dB(V) inputs,
but you will need to make sure that the neg-
ative terminals are not connected.
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Digital 1/0

This section contains connectors for eight chan-
nels each of AES/EBU I/O, TDIF I/O, and Optical
(ADAT) I/O. Only one digital format can be used
at a time.

AES/EBU DB-25 connectors for eight channels
of AES/EBU input and output. Each of the paired
channels is a balanced three-conductor signal,
and supports 192 kHz sample rates in dual-wire
mode. Dual-wire mode uses two of 192 I/O’s
physical I/O channels of AES/EBU I/O to carry
each single stream of 192 kHz audio. Therefore,
only four simultaneous channels of AES/EBU
I/O are available at 192 kHz.

TDIF DB-25 connectors for eight channels of
TDIF input and output. Conforms to standard
eight-channel TDIF pinouts.

For more information, see Appendix B, “Pinout
Diagrams for the DB-25 Connectors.”

Optical (ADAT) Dedicated, eight-channel 24-bit
capable Optical port. Using real-time sample
rate conversion, these inputs will accept up to
48 kHz sample rates and convert them to a

Pro Tools session running at up to 192 kHz.
These outputs will only output at sample rates of
up to 48 kHz. Unlike the Optical port located on
the enclosure, this Optical (ADAT) port is not
switchable to Optical S/PDIF.

The inputs on the Digital I/O Card feature real-
time sample rate conversion. For example, you
can stream audio with a sample rate of 44.1 kHz
into a 96 kHz session.

For more information, see the Pro Tools|HD Get-
ting Started Guide.



Enclosure Connectors

The right half of the back panel of 192 /O fea-
tures a set of non-removable connectors that are
mounted to the enclosure.

These connectors feature two additional chan-
nels of AES/EBU I/O and another eight channels
of Optical I/O. These ports appear on-screen in
Pro Tools as AES/EBU [Encl], and

Optical (ADAT) [Encl]. The reference to the en-
closure [Encl] differentiates the chassis-
mounted ports from the I/O of the same types
on the Digital I/O Card.

Also mounted on the enclosure are two chan-
nels of S/PDIF I/O on RCA connectors, Loop
Sync, External Clock, and ports for attaching the
192 1/0 to Pro Tools|HD cards and other audio
interfaces.

AES/EBU [Encl]

These are balanced, three-conductor XLR con-
nectors that accept and output a stereo, 24-bit
AES/EBU digital data stream. These two ports
support up to 96 kHz sample rates. The enclo-
sure ports do not support dual-wire mode (re-
quired for 176.4 kHz and higher sample rates),
or provide real-time sample rate conversion (use
the ports on the Digital I/O card for these fea-
tures).

S/PDIF Stereo 1/0

These are unbalanced, two-conductor RCA jacks
that accept and output a stereo S/PDIF digital
data stream. S/PDIF supports up to 24-bit audio,
at sample rates up to 96 kHz.

Optical (ADAT) [Encl]

These are Optical ports that accept up to eight
channels of Optical (ADAT) input and output,
or two channels (stereo) optical S/PDIF input
and output. Optical (ADAT) mode supports sam-
ple rates up to 48 kHz. In TOS-Link mode, sup-
ports two-channel Optical input and output at
sample rates up to 96 kHz. This port does not
feature real-time sample rate conversion.

About Lightpipe-Compatible Devices

Lightpipe is an industry standard, eight-channel
optical digital audio connection created by Ale-
sis. Lightpipe is found on many devices, includ-
ing Optical (ADAT) decks, modular digital mul-
titracks (MDMs), sound cards, A/D or D/A
converters, and digital consoles.

LOOP SYNC In and Out

Loop Sync is a dedicated clock loop for synchro-
nizing multiple Pro Tools|HD peripherals to-
gether (multiple audio interfaces, and/or a
Digidesign SYNC I/O and one or more audio in-
terfaces). Loop Sync uses a word clock signal
based on sample rates of either 44.1 kHz or

48 kHz. As sample rate increases in the system,
Loop Sync continues to operate at a base rate of
44.1 kHz or 48 kHz, depending upon the higher
rate.

The Loop Sync In and Out ports are standard
BNC connectors that output a 1x Loop Sync
clock signal. Loop Sync should only be used to
chain multiple Pro Tools|HD peripherals to-
gether.

Chapter 2: 192 I/0 Overview 9



EXT. CLOCK In and Out

The External Clock I/O ports are standard BNC
connectors that receive and output a word clock
signal. These ports can be used to synchronize
the 192 I/O to any device that requires (or pro-
vides) word clock.

External Clock In and Out are configured by
your choice for Clock Source in Pro Tools.

"C¥ Because crucial timing data is passed
through the Loop Sync and Word Clock
ports, you should use high-quality, 75-ohm
RG-59 cables for making connections.

AC Power

This connector accepts a standard AC power ca-
ble. The 192 I/O is auto power-selecting (100V
to 240V) and will automatically work with a
standard modular cable to connect to AC power
receptacles in any country.

Primary DigiLink

The Primary port is where the DigiLink cable
connects a Pro Tools|HD card (or other audio in-
terface) to the 192 I/O. The Primary DigiLink
port sends and receives all 32 I/O channels. As
the 192 I/O is a 16-channel only device, chan-
nels 17-32 are passed through to the Expansion
or Legacy port.

10 192 I/0 Guide

DigiLink Length Specifications

There are five different lengths of DigiLink ca-
bles.

e 18”7 (0.46m), included with each interface

e 12’ (3.6m), included with each
Pro Tools|HD card

e 25’(7.62m)

e 507 (15.25m), the maximum length sup-
ported for 192 kHz sessions (sold sepa-
rately)

e 100’ (30.5m), the maximum length sup-
ported by 96 kHz sessions (sold separately)

(Y For more information about DigiLink ca-
bles, refer to the Digidesign Web site
(www.digidesign.com).

Expansion DigiLink

The Expansion port lets you connect an addi-
tional Pro Tools|HD audio interface to the
192 1/0. The Expansion port passes channels
17-32 to the secondary, or expansion I/O.

Legacy Port

This port lets you connect MIX-series Digidesign
audio interfaces to the 192 I/O. You can connect
two eight-channel interfaces (such as the 888|24
or 882|20) or a single sixteen-channel interface
(such as the 1622 I/O, or 24-bit ADAT Bridge
1/0) for expanded input and output options, us-
ing their original cables.

When the Legacy port has been activated from
within Pro Tools, your MIX-series I/O will ap-
pear as channels 17-32 in Pro Tools.

Q For more information on using Expansion
or Legacy audio interfaces, see the
Pro Tools|HD Getting Started Guide, and the
Expanded Systems Guide.



Legacy and Expansion Peripheral Port
Limitations

Because both the Legacy port and the Expansion
port use channels 17-32, you can only use one
at a time.

The Legacy port is not available in any session in
which the sample rate is set for higher than
48 kHz.

Accessory Port

This port is not supported.

Using Input and Output Trims

Input Trims

The Input Trims below the two DB-25 connec-
tors on the Analog In card are used to store two
different calibration settings (A and B) for each
channel.

These two adjustable Input Trims are for pre-
cisely calibrating and switching between a
choice of independently adjustable headroom
settings for each channel. You can adjust each
Input Trim by hand with a small screwdriver.

For example, you could use the A trims for the
+4 dBu port, and use the B trims for —-10. Or, use
A and B to maintain two different trims for any
signal input port (+4 dBu or -10 dB(V)).

If you are not using the -10 dB(V) input connec-
tor, the B trims can be used to store an alternate
set of headroom values for the +4 dBu inputs.
Once set, you can switch between the different
trim headroom values for the same input level
from within Pro Tools.

About Input Operating Levels

Check the owner’s manual for your mixer,
power amplifier or effects processor to see if it
operates more comfortably at line level, in
which case consider setting the 192 I/O to oper-
ate at —10 dB(V) line levels and/or adjusting the
Input Trims.

Consider the following when connecting a
mixer:

« If your mixer cannot handle more than 1.5V
(RMYS) inputs at +4 dBu, then you should set the
192 1/O to operate at —-10 dB(V) line level.

& If your mixer can handle up to 15.5V (RMS)
inputs, or has pads or attenuators on its inputs,
then you can use the +4 dBu setting on the
192 1/0.

¢ 192 1/0O is calibrated for 18 dB headroom at
the +4 dBu setting.

Most manuals contain device input specifica-
tions, including whether or not there are pads or
attenuators. Consult the manufacturer’s docu-
mentation for your mixer or power amplifier for
further information.

Selecting Analog Input Operating
Levels

If you want to switch the input levels of the

192 1/O from +4 dBu to -10 dB(V), you can ac-
cess these parameters on a channel-by-channel
basis in the Hardware Setup dialog. For instruc-
tions, see the Pro Tools|HD Getting Started Guide

Chapter 2: 192 |/0 Overview
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Soft Clip Limiting

The 192 I/O provides an optional “soft” limiter
for each input. The Soft Clip limiter can be used
to attenuate incoming analog signals to provide
extra protection from temporary clipping tran-
sients and digital distortion.

With Soft Clip enabled, 192 I/O supports an ad-
ditional 4 dB of headroom by rounding off the
top 4 dB to the clip point.

For more information on Soft Clip Limiting
and other 192 I/0O settings, see the
Pro Tools|HD Getting Started Guide.

Output Trims

18 dB and 20 dB Output Levels

The 192 1/O has two Output Trims for each out-
put signal. You can switch between these Out-
put Trim levels from within Pro Tools.

e Output Trim A is factory calibrated for 18 dB
headroom.

e Output Trim B is calibrated for 20 dB head-
room.

Q For more information, see Appendix C,
“192 1/O Calibration Mode Instructions.”
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Digital Format Settings and
Sample Rate Conversion

The 192 I/O lets you specify the digital format
for input, and apply sample rate conversion.

To configure digital formats and sample rate
conversion:

1 Launch Pro Tools.
2 Choose Setup > Hardware.

3 Click the Digital tab and select Input Format
(AES/EBU, ADAT, or TDIF).

4 Enable real-time Sample Rate Conversion by
selecting channel pairs (1-2, 3-4, 5-6, 7-8) in
the SR Conversion box on the Digital tab.

Q At session sample rates above 48 kHz, sam-
ple rate conversion for the TDIF and Optical
(ADAT) inputs on the Digital I/O card is au-
tomatically enabled on all eight inputs of
the selected format.

For more information, see the Pro Tools|HD Get-
ting Started Guide.



Adding or Removing 1/0 Cards

The 192 I/O comes with one available expan-
sion bay on the back of the unit. This bay lets
you add another 192 AD Card, 192 DA Card, or
192 Digital Card (all sold separately) to increase
the amount of available I/O on the unit.

The expansion bay is the only bay that allows
for another card. The other three bays are hard-
wired for the appropriate card (the upper left
bay houses a 192 AD card; the upper right, the
192 Digital card; and the lower left, the 192 DA
card). See “Installing an I/O Card” on page 13.

Bay Card
Number Allowed
1 A/D

2 D/A

3 D/D

4 Any

A\ 1t is important that you follow the guidelines
in this chapter to avoid damaging your
192 I/O or any of your I/O cards.

These factory-installed cards can be removed, if
needed, for servicing, or to swap out cards in the
fourth bay for different studio setups. If you re-
move a single card from the 192 I/O, the unit
will continue to function while the audio card is
being serviced. See “Removing an I/O Card” on
page 16.

Installing an 1/0 Card

Installing an optional card in the expansion bay

To insert or replace a card:

1 Power off and disconnect the 192 I/O from
your Pro Tools|HD system.

2 Make sure that the equipment is properly
grounded.

3 Remove all 16 of the small Phillips-head
screws around the edges of the top cover. Don't
lose the screws—put them in a safe place!

Removing the top cover screws

Appendix A: Adding or Removing |/O Cards
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4 Lift off the top of the 192 I/O and set it aside.

5 Remove the five screws on the cover over the
empty bay. Do not misplace these screws; note
that they are a different size and shape from the
top cover screws.

Placing the edge of the card into the guide rails

7 Slide the edges of the card into the guide rails
on each side of the bay.

8 Gently push the card back into the bay, lifting
slightly to keep components underneath the
card from touching the back panel.

Removing the cover on the empty bay

6 Look into the empty bay to locate the guide
rails for the card to slide in on.

Lifting slightly while pushing the card back into the bay

9 Attach the card’s faceplate onto the back
panel surface of the 192 I/O with the same
screws you removed from the empty bay cover.

Locating guide rails along sides of empty bay

Attaching the card faceplate into the back panel
surface of the 192 1/0
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10 Locate the raised ridge in the middle of the
50-pin cable which connects to the 192 I/O
chassis. This ridge is only on one side of the con-
nector, and there is a matching groove on only
one side of the 50-pin connector on the card.

%

B L r & k]
Locating the ridge on the 50-pin cable and the matching
groove on the 50-pin connectors on the card

11 Gently push the cable connector into the
card’s connector. The ridge on the cable connec-
tor must line directly into the groove on the
card connector. Be very careful not to bend any
of the pins or to over-stress the card.

Pressing the 50-pin cable connector into the card
12 Place the top cover onto the 192 I/0O.

13 Replace the original screws.

14 Connect the 192 I/O to your Pro Tools|HD
system.

15 Power on your 192 I/0O.

16 When you power on the unit, the power LED
should turn orange.

17 Start up the computer.

18 When you boot up the computer, the power
ring should turn from orange to green.

If it doesn’t, see “Troubleshooting” on page 16.

19 If the ring turns green, and the computer
boots properly, launch Pro Tools.

20 Open the Hardware Setup dialog to confirm
that the new card is recognized:
¢ If you installed a 192 Digital card, you
should see a new tab called Digital 9-16.
e If you installed a 192 AD card, you should
see a new tab called Analog In 9-16.
e If you installed a 192 DA card, you should
see a new tab called Analog Out 9-16.

21 If the new card does not appear in the Hard-
ware Setup dialog, power down, check the seat-
ing of the card, and recheck the cables inside the
192 1/0.

Appendix A: Adding or Removing |/0 Cards
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Hardware Setup Changes After
Adding a Card

The additional inputs and/or outputs provided
by the new card will appear in the Hardware
Setup dialog, with the same controls and param-
eters as for the original card of the same type.

For example, if you add an Analog Input card to
the original three cards, a second Analog Input
tab will appear in the Hardware Setup dialog.
You can route these new inputs (which will in
this case be called Analog Inputs 9-16) with the
same controls and parameters as the factory-in-
stalled version of the card.

Q Whenever a card is added or removed from
"~ an Pro Tools|HD 1/O, the routing in the

Hardware Setup dialog will revert to default
assignments. If you have complex routing
and or mirroring in place, please note the as-
signments and reassign the inputs and out-
puts after the new card has been properly
identified.

Troubleshooting

If the power ring does not turn from orange to
green when you boot the computer, make sure
you reconnected the DigiLink cable to the Pri-
mary port on the back of the unit. If the Dig-
iLink cable is securely fastened and the other
end is plugged into an HD Core or Process card
in a computer that is booted, you may have in-
advertently disconnected another 50-pin cable
when installing the card.
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Removing an 1/0 Card

In the event of a problem with one of the cards
in your 192 [/O, you can remove the card and
send it to Digidesign for repair.

The modular nature of the Pro Tools|HD system
allows you to simply return the specific card, in-
stead of the entire 192 I/O. Your Pro Tools|HD
system will continue to function while missing a
single card. It will not function if more than one
of the factory-installed cards is missing, or if the
wrong card is in detected in any of the first three
bays.

A Before handling any of the cards or internal
components of 192 1/0O, discharge any static
electricity by touching the outer casing of the
power supply.

To remove an 1/0 card from the 192 1/0:

1 Power off and disconnect the 192 I/O from
your Pro Tools|HD system.

2 Make sure that the equipment is properly
grounded.

3 Remove the top cover of the 192 I/O by ex-
tracting the 16 small Phillips-head screws
around the edges of the top cover, and lift it off.
Put the screws in a safe place.

4 Remove the five screws on the front plate of
the card to be removed.

5 Gently pull the 50-pin connector off of the
edge of the card.



6 Pull the card out by gripping the edges be-
tween your thumb and forefinger. Pull straight
back, lifting very slightly to avoid contact be-
tween components on the underside of the card
and the 192 I/O back panel faceplate.

A When you pull a card out, pay particular at-
tention to keeping components on the sur-
faces of the card from bumping into any of
the internal components or the back panel
faceplate on the 192 I/0.

Hardware Setup Changes After
Removing a Card

In this case, the Hardware Setup dialog will re-
flect the change by greying out the removed in-
puts and outputs, and reverting them to their
default assignments. The remaining inputs and
outputs will function normally.

For example, if you remove the Analog Input
card, the Analog Input tab will disappear from
the Hardware Setup dialog.

You will lose the configuration of any pairs of
inputs or outputs that were assigned to the card
being removed.

Appendix A: Adding or Removing |/O Cards
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appendix b

Pinout Diagrams for the DB-25 Connectors

Analog Output DB-25 Analog Input (+4 dBu) DB-25
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Analog Input (-10dB(V)) DB-25

CH1_HoT |24
1 | cwi_cowo |12
CH1_GND |25
CHz_vot |10
2 cH2_coLp | 23
cH2_GND |11
cH3_vot |21
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[ = M
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AES/EBU DB-25

CH12_RCV_HOT
CH12_RCV_COLD
CH12_RCV_GND

24
12
25

CH34_RCV_HOT
CH34_RCV_COLD
CH34_RCV_GND

23

11

CH56_RCV_HOT
CH56_RCV_COLD
CH56_RCV_GND

21

22

CH78_RCV_HOT
CH78_RCV_COLD
CH78_RCV_GND

20

CH12_XMT_HOT
CH12_XMT_COLD
CH12_XMT_GND

18

19

XMT

CH34_XMT_HOT
CH34_XMT_COLD
CH34_XMT_GND

17

5-6
XMT

CH56_XMT_HOT
CH56_XMT_COLD
CH56_XMT_GND

15

16

7-8
XMT

CH78_XMT_HOT
CH78_XMT_COLD
CH78_XMT_GND

14

NC_1
MH1
MH2

13 ™
26

27




TDIF DB-25
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192 1/0 Calibration Mode Instructions

Before you use the 192 I/O audio interface, you
may want to calibrate its input and output levels
to the level of your mixing console.

The 192 I/O has +4 dBu and -10 dB(V) inputs,
and +4 dBu outputs, each with their own trim
pots for proper calibration.

The 192 1/0 is factory-calibrated so that its

+4 dBu input operating level is set for 18 dB
headroom above +4 dBu (maximum input/out-
put +22 dBu).

If you need to recalibrate your 192 I/O or other
components of your studio, you can use the
alignment procedure described in this chapter.

About Calibration

Calibrating levels on a digital recording device is
different from calibrating levels on an analog re-
cording device. Unlike analog devices, most dig-
ital devices do not have a standard “0 VU” level
setting that corresponds to nominal input and
output levels. Instead, with an interface such as
the 192 I/O, the meters are calibrated in decibels
below peak or dBFS (dB full scale)—digital clip-
ping level.

Headroom

The concept of headroom is slightly different for
analog and digital devices.

Analog Most analog devices allow for a certain
amount of headroom above 0 VU. If you send a
signal above 0 VU to an analog recorder, you
still have a margin of headroom, and if tape sat-
uration occurs, it does so fairly gracefully, giving
the audio a compressed sound that some find
desirable.

Digital Digital devices, on the other hand, do
not allow for signals that exceed the dynamic
range of the input or dBFS (dB full scale). When
a signal exceeds the maximum input level for a
digital device, clipping occurs, causing digital
distortion, which is harsh and usually undesir-
able.

The Calibration Process

Analog To calibrate the input level of an analog
device to a mixing console’s output level, you
would typically send a 1 kHz tone at 0 VU from
the console to the analog deck and align the re-
cording deck’s meters to read O VU.

Appendix C: 192 |/0 Calibration Mode Instructions
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Digital With a digital recording device such as
the 192 I/0, in order to allow for headroom, you
must align a O VU tone from the console to a
value less than zero (or below dB full scale

[-x dBEFS]) on the 192 I/O, by exactly the
amount of headroom that you want.

For example, to have 12 dB of headroom above
0 VU with the 192 I/O, you must align the in-
coming 0 VU 1kHz tone to a level of —12 dBFS.
For 18 dB of headroom, you would align it to
—-18 dBFS. (Since it is assumed that you are using
the 192 I/O with a +4 dBu device or console, a
0 VU signal level coming out of the device or
console is actually equivalent to a nominal

+4 dBu level signal.)

Calibrating the 192 1/0

To calibrate the 192 I/O you put Pro Tools in a
special operating mode called Calibration mode,
then use the Signal Generator plug-in to gener-
ate a test tone for alignment.

The Pro Tools installer includes a standard
8-channel calibration session for the 192 I/O.
You can use this session as is and change the in-
put and output assignments for more 192 I/O
channels or use it as a base to make your own
calibration template.

The following instructions show how the cali-
bration session was created. You can create a ses-
sion from scratch or open the calibration tem-
plate and walk through these instructions.

A\ Turn down your monitoring system before
beginning calibration. The Signal Genera-
tor plug-in emits a continuous signal when
inserted on a track.
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To calibrate the 192 1/0 Outputs:

1 Launch Pro Tools and create a new session.

2 Choose Setup > Preferences and click Opera-
tion.

3 Enter the desired Calibration Reference Level
value in dB. A level of -18 dB is typical. (It is not
necessary to type a minus sign here.)

4 Click OK.

5 Create a new mono audio track by choosing
Track > New.

6 Insert the Signal Generator plug-in on the
track.

7 Set the Signal Generator plug-in output level.
This should be the same value you entered as
the Calibration Reference Level (such as-18 dB).

8 Set the Signal Generator frequency to

1000 Hz. 1000 Hz is typical, but any frequency
will work. Other typical values are 250 Hz and
500 Hz.

9 Set the Signal Generator signal waveform to
Sine.

10 Route the track’s output to Bus 1. In the cal-
ibration template, Bus 1 has been renamed to
“1k Tone.”

11 Create a mono Auxiliary Input track for each
192 1I/O output you want to calibrate. Set the
output assignment for each of these Auxiliary
Inputs to its respective I/O output.

12 Set the input of each Auxiliary Input track to
Bus 1, or 1k Tone for the template session.



13 Create an additional mono Auxiliary Input
track for each input you want to calibrate. Set
the input assignment for each of these Auxiliary
Inputs to its respective I/O input. Then set the
output of each of these Auxiliary Inputs to an
unused bus pair (for example Bus 3-4). In the
template session the bus names are Null and
Out. This makes sure feedback doesn’t occur
when monitoring main outputs 1-2.

14 Connect an external VU meter to each of the
I/O outputs in turn. (One at a time as you cali-
brate.)

15 Set all Pro Tools track faders to their default
of 0 dB by Alt-Shift-clicking (Windows) or Op-
tion-Shift-clicking (Mac) any fader.

16 The trim pots are located at the back of the
unit, underneath the DB-25 connector. The de-
fault trim assignment is “A.” If you wish to cali-
brate both the A and B trims, select the active
trim in the Analog Output tab in the Hardware
Setup dialog.

17 Adjust the I/O output level trim pot with a
small, flat-head screwdriver to align the outputs
to read “0 VU” on the external VU meter. We
recommend using a tweaker tool with a recessed
flat-head surrounded by a plastic tube to hold
the trim pot. Tweakers can usually be found at
electronic supply stores.

To calibrate the 192 1/0 inputs:

1 Connect the 192 I/O outputs to a bank of
192 1/0 inputs by doing either of the following:

e Use a DB-25 to DB-25 straight through ca-
ble.

e Interconnect the XLR ends of DB-25-to-
XLR together.

2 In Pro Tools, select Options > Calibration
Mode.

The names of all uncalibrated tracks begin to
flash. In addition, the track volume indicator of
each Auxiliary Input track receiving an external
input signal now displays the reference level
coming from the calibrated output (default is
-18 dB).

3 Adjust the 192 I/O input level trim pots with
the same small flat-head screwdriver or tweaker.
It is best to calibrate the inputs with the back of
the 192 I/O facing you and the Pro Tools screen
well in sight. If you cannot see the Pro Tools
screen, consider asking another person to assist
you with the input calibration. When the level
is properly matched, the track name will stop
flashing and the peak volume indicator will in-
dicate your headroom value (the default is
“-18.0").

The Automatch indicator arrows on each track
show the direction of adjustment required for
alignment:

¢ When the incoming level is higher than the
reference level, the down arrow will appear lit
(blue). In this case, trim the I/O input level
down.

¢ When the incoming level is lower than the
reference level the up arrow will appear lit (red).
In this case, trim the I/O input level up.

Appendix C: 192 |/0 Calibration Mode Instructions
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When you have properly aligned the incoming
peak signal levels to match the calibration refer-
ence level, both Automatch indicator arrows
will light: the up arrow red and the down arrow
blue.

Above the fader is a peak volume indicator. This
indicator will show the dB level above and be-
low your chosen headroom value. If the peak in-
dicator is showing -19.1, you are —-1.1 dB below
a headroom value of —18 dB. If the display is
showing -16.5, you are +2.5 dB above your
headroom value of -18 dB.

4 When you have finished, deselect Options >
Calibration Mode.

Calibrating a System with Both
192 1/0 and 96 1/0 Audio
Interfaces

The “A” trim on the192 I/O is factory preset
with 18 dB of headroom in its +4 dB line level
operating mode. The 96 1/O, however, is fixed at
14 dB of headroom and its inputs are not adjust-
able.

When setting up a 96 1/O (particularly in sys-
tems using a combination of the 192 I/O and
96 1/0s), it may make sense to calibrate all I/Os
for —-14 dB headroom. This helps ensure that re-
corded audio files have the same relative levels
regardless of which interface is used for record-
ing.
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